
As 2024 gets fully underway new features and updates are coming thick and fast like an out of control 
milkshake machine!  This month’s newsletter looks at some of the big news stories, including great news about Copilot, debugging formulae with 
Excel Labs and a new experimental feature (Sheet Defined Functions), plus news on creating PivotTables on an iPad and the new DAX INFO functions 
for DAX query view in Power BI.

We could stop right there – but of course, we won’t!

There are most of the usual suspects too.  Whilst it’s all quiet regarding New Features in Excel, there is plenty more 
to get your teeth into.  We have our latest Beat the Boredom Challenge, together with the usual tips on Charts & 
Dashboards, Excel for Mac, Visual Basics, Power Pivot Principles, Power Query Pointers, Power BI Updates, the A to Z 
of Keyboard Shortcuts and we “minute” more of the Excel functions.

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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As we have reported recently, Microsoft’s Artificial Intelligence (AI) tool, 
Copilot, has been released into the wild, albeit for companies wishing 
to make a purchase for at least 300 users.  Even so, the software giant 
announced it had reached another milestone in trying to connect with 
the world with more than 5 billion chats and more than 5 billion images 
to date.  

Microsoft is starting to learn how people are using it.  Firstly, there is a 
set of Copilot power users including creators, researchers, programmers 
and others who want more rapid access to the very latest Microsoft has 
to offer.  Secondly, there is another group of Microsoft 365 users who 
wish to use it for personal use.

To help address those needs, Microsoft has just announced more options 
for power users, creators and anyone looking to take their Copilot 
experience to the next level.  This begins with the introduction of Copilot 

Pro, a new premium subscription for individuals that provides a higher 
tier of service for AI capabilities, brings Copilot AI capabilities to Microsoft 
365 Personal and Family subscribers, and new capabilities, such as the 
ability to create Copilot GPTs.  Furthermore, they are also announcing 
the General Availability of their Copilot app for iOS and Android phones.  
Finally, and arguably most importantly, Copilot for Microsoft 365 is to 
be brought to more commercial customers by expanding the availability 
to businesses of all sizes, including small- and medium-sized businesses, 
starting right now.

Copilot Pro is a new subscription that delivers the most advanced 
features and capabilities of Microsoft Copilot to individuals looking to 
obtain Copilot.  This software can assist with writing, coding, designing, 
researching or learning, as required.

Copilot for All (sort of…)

http://www.sumproduct.com
http://www.sumproduct.com/thought
mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Copilot Pro provides:

	 •	 a single AI experience that runs across your devices, understanding your context on the web, on your PC, across your apps and soon on 	
		  your phone 

	 •	 access to Copilot in Word, Excel (Preview only, just in English), PowerPoint, Outlook and OneNote on PC, Mac and iPad for Microsoft 365 	
		  Personal and Family subscribers

	 •	 priority access to the very latest models, beginning with OpenAI’s GPT-4 Turbo

	 •	 enhanced AI image creation with Image Creator from Designer (formerly Bing Image Creator) 

	 •	 the ability to build your own Copilot GPT (Generative Pre-trained Transformer), a customised Copilot tailored for a specific topic – in the 	
		  coming soon Copilot GPT Builder with just a simple set of prompts.

While Copilot Pro (priced at US$20 per month per user) is aimed at individuals, Copilot for Microsoft 365 is aimed at organisations.  Copilot for 
Microsoft 365 became Generally Available for enterprises in November, with 40% of the Fortune 100 participated in the Early Access Program.  
However, Copilot for Microsoft 365 is now available for organisations of all sizes — with no seat minimum.  About time!

These latest updates include the following information:

	 •	 Copilot for Microsoft 365 is now Generally Available for small businesses with Microsoft 365 Business Premium and Business Standard  
		  Customers can purchase between one and 299 seats for a price of US$30 per month per user

	 •	 The 300-seat purchase minimum for commercial plans has been removed.  Microsoft has made Copilot available for Office 365 E3 and E5 	
		  customers (a Microsoft 365 license was previously required)

	 •	 This builds on December’s announcement of Copilot for Microsoft 365 being available for education faculty and staff.

Copilot for Microsoft 365 has greater power for organisations because it works across your entire universe of data at work including emails, meetings, 
chats, documents and more, plus the web.  With natural language prompts like “Tell my team how we updated the product strategy,” Copilot can 
generate a status update based on the morning’s meetings, emails and chat threads. 

As the availability of Copilot expands to more people, there is still a free experience for anyone interested in exploring how Copilot can transform 
productivity and creativity using AI.  You can find out more by visiting copilot.microsoft.com.

The latest features include:

	 •	 Copilot GPTs: these let you customise the behaviour of Microsoft Copilot on a topic that is of particular interest to you.  A handful of 	
		  Copilot GPTs will start to roll out with specific purposes such as fitness, travel, cooking and more.  Soon, Copilot Pro users will also be able 	
		  to create their own Copilot GPTs using Copilot GPT Builder

	 •	 Copilot mobile app: this is now available for Android and iOS.  The Copilot app gives you the power of Copilot on the go as your Copilot 	
		  queries and chats will roam across your phone and PC.  The Copilot mobile app includes the same capabilities of Copilot on your PC 	
		  including access to GPT-4, Dall-E 3 for image creation, and the ability to use images from your phone when chatting with Copilot 
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	 •	 Copilot in the Microsoft 365 mobile app: Microsoft is also adding Copilot to the Microsoft 365 mobile app for Android and iOS for 	
		  individuals with a Microsoft account.  This new feature is rolling out over the next month.  Access Copilot right inside the app and easily 	
		  export the content you create to a Word or PDF document. 

With these latest announcements, Copilot is coming to more of us.  Let’s hope it gets to all who want it very soon.  

You may know SumProduct work as model auditors amongst other 
duties: have you ever thought of calling us in?  On occasion, it’s likely you 
have found yourself tangled in a web of complex Excel formulae, trying 

to identify the source of an error.  Well, you might want to know that the 
latest experiment from Excel Labs is a new formula debugger, available 
within the Advanced Formula Environment (AFE).

The debugging capabilities are activated using the new button on the Grid page in AFE.  When the button is activated, the debugger will be visible 
in the same editing pane, and you are ready to go.

Here are some of the key features to look out for:

	 •	 Live debugging: the debugger updates as you type, making it quick to explore how different variations of a formula are evaluated

Debugging Formulae with Excel Labs
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	 •	 Evaluation steps: each evaluation step is shown, with highlights and underlines making it easy to see what changed at every step

	 •	 Range preview: view a preview of the grid when hovering over a reference.  Previews show the surrounding context to make it easier to 	
		  navigate

	 •	 LAMBDA debugging: you may debug LAMBDA formulae, such as SalesForBestCategory, shown below.  Every function call is contained in 	
	 	 an expandable card.  This lets you dive into the particular functions you are interested in, to see how they evaluate.
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Not all functions are supported just yet (XLOOKUP is one notable absentee).  If a function or scenario is blocking your work, Microsoft has asked that 
you let them know through the usual feedback channels.

The debugger will be pushed to Excel Labs automatically and there is no need to explicitly update the add-in. If you do not have Excel Labs, you can 
install the add-in from the Office store.

Another experimental feature in the Advanced Formula Environment 
(AFE) is the ability to automatically convert a multi-cell calculation into a 
function, also known as sheet-defined functions. This capability has been 
part of AFE for a while, but we thought we’d take this opportunity to 
explain it.

Often, modellers find themselves spreading a complex calculation over 
many cells (“Rule of Thumb” anyone?), like this one, that extracts an ID 
from a piece of text:

After writing the calculation, we are faced with either many intermediate cells or we must roll the formulae into one single “mega-formula”.   
With AFE and the ‘Add function from grid’ feature, we can automatically convert these formulae into a tidy function using three simple steps:

	 1. 	 Select the range containing the formulae that will make up the function

	 2. 	 Click the ‘Add function from grid’ button and provide the references that will define the inputs and outputs.  Sometimes, AFE can  
		  automatically detect the inputs and outputs based upon the dependencies

	 3.	 AFE will present you with the generated function that combines the formulae in the range.  If you use labels adjacent to formulae, AFE 	
		  can also use those to generate friendly parameter names, like ‘Text’ or ‘After’.

Sheet-defined Functions within the Advanced Formula Environment (AFE)

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Microsoft has just announced support for PivotTable creation and editing 
on an iPad.  This useful data analytical tool is now available for the iPad's 
smaller screen and touch interface.  This gives you have the flexibility to 
move seamlessly between desktop, web and iPad whilst maintaining a 
consistent experience across the board. 

To get started, navigate to the Insert tab in Excel on your iPad, select 
PivotTable, and choose a ‘Source’ and ‘Insertion’ location.  You can insert 
your PivotTable with a single tap:

You may tailor a PivotTable to your precise needs using the field list.  The areas section at the bottom allows you to rearrange fields by dragging them 
across the different sections to achieve the required results.

PivotTables Now on iPad
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You may adjust your PivotTable’s source data by navigating to the PivotTable tab and interacting with the ‘Change Data Source’ side pane.  

You may fine-tune your PivotTable by accessing the Settings side pane.  There, you may make the desired modifications and save your changes with 
a simple tap to make your PivotTable work precisely how you want it to. 
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You can move your PivotTable within and across worksheets through cut and paste in the context menu too.

To use this feature, you need to be running Excel on iPad version 2.80.1203.0 and above. 
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We’ve talked about DAX query view quite a bit recently.  Since it was 
released in public Preview back in November, upcoming / current Power 
BI Desktop releases will now include the new INFO DAX functions and 
improvements to the Update model CodeLens.

It shouldn’t be understated just what has hit Power BI.  There are more 
than 50 new INFO DAX functions now available!  If you’re familiar with 
the Dynamic Management Views (DMVs) of models in Power BI, Azure 
Analysis Services and SQL Server Analysis Services, you might recognise 
these as the TMSCHEMA DMVs.  The existing TMSCHEMA DMVs are now 
available as DAX functions.  Providing them as DAX functions gives the 
following benefits:

	 •	 no longer do you have to use a different query syntax than  
		  DAX to see information about your semantic model.  These  
		  are native DAX functions and show in IntelliSense when you  
		  type INFO

	 •	 they may be combined with other DAX functions.  Existing 		
		  DMV query syntax does not allow you to join them.  As a DAX 	
		  function, the output is a Table data type and existing DAX  
		  functions that join tables or summarise tables may be used.

•	 INFO.ALTERNATEOFDEFINITIONS
•	 INFO.ANNOTATIONS
•	 INFO.ATTRIBUTEHIERARCHIES
•	 INFO.ATTRIBUTEHIERARCHYSTORAGES
•	 INFO.CALCULATIONGROUPS
•	 INFO.CALCULATIONITEMS
•	 INFO.COLUMNPARTITIONSTORAGES
•	 INFO.COLUMNPERMISSIONS
•	 INFO.COLUMNS
•	 INFO.COLUMNSTORAGES
•	 INFO.CULTURES
•	 INFO.DATACOVERAGEDEFINITIONS
•	 INFO.DATASOURCES
•	 INFO.DELTATABLEMETADATASTORAGES
•	 INFO.DETAILROWSDEFINITIONS
•	 INFO.DICTIONARYSTORAGES
•	 INFO.EXPRESSIONS
•	 INFO.EXTENDEDPROPERTIES
•	 INFO.FORMATSTRINGDEFINITIONS
•	 INFO.GENERALSEGMENTMAPSEGMENTMETADATASTORAGES
•	 INFO.GROUPBYCOLUMNS
•	 INFO.HIERARCHIES
•	 INFO.HIERARCHYSTORAGES
•	 INFO.KPIS
•	 INFO.LEVELS
•	 INFO.MEASURES 

•	 INFO.MODEL
•	 INFO.OBJECTTRANSLATIONS
•	 INFO.PARQUETFILESTORAGES
•	 INFO.PARTITIONS
•	 INFO.PARTITIONSTORAGES
•	 INFO.PERSPECTIVECOLUMNS
•	 INFO.PERSPECTIVEHIERARCHIES
•	 INFO.PERSPECTIVEMEASURES
•	 INFO.PERSPECTIVES
•	 INFO.PERSPECTIVETABLES
•	 INFO.QUERYGROUPS
•	 INFO.REFRESHPOLICIES
•	 INFO.RELATEDCOLUMNDETAILS
•	 INFO.RELATIONSHIPINDEXSTORAGES
•	 INFO.RELATIONSHIPS
•	 INFO.RELATIONSHIPSTORAGES
•	 INFO.ROLEMEMBERSHIPS
•	 INFO.ROLES
•	 INFO.SEGMENTMAPSTORAGES
•	 INFO.SEGMENTSTORAGES
•	 INFO.STORAGEFILES
•	 INFO.STORAGEFOLDERS
•	 INFO.TABLEPERMISSIONS
•	 INFO.TABLES
•	 INFO.TABLESTORAGES
•	 INFO.VARIATIONS.

New INFO DAX Functions

Here’s the full list of the new INFO DAX functions (deep breath):

In particular: 

	 •	 INFO.TABLES contains information about the tables in the model, such as the table name, description and whether it is hidden or not

	 •	 INFO.COLUMNS contains information about the columns in a model, such as the column name, data type and whether it is hidden or not

	 •	 INFO.MEASURES contains information about the measures in the model, such as the measure name, expression and format string. 

For example, let’s look at INFO.MEASURES and demonstrate now it may be joined to other INFO functions in DAX query view.  Microsoft has a file, 
Store Sales (PBIX), that you may download from https://learn.microsoft.com/power-bi/create-reports/sample-datasets#updated-samples if you 
wish to follow along.
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In Power BI Desktop. go to DAX query view and type in EVALUATE followed by INFO to see them all listed:

I can continue typing or scroll down to INFO.MEASURES.  Then I click run or F5 (now recognised in Power BI).  You can also use the maybe lesser-
known keyboard shortcut, CTRL + SHIFT + E, to run the DAX query too.
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Now I can see all the measures in my model, their expression, and other 
useful information about them.  It also gives me their home table but in 
maybe a slightly less useful TableID column.  Thankfully, there is an INFO.

TABLES DAX function which has the names of tables 10 and 13.  To join 
them, I will use SELECTCOLUMNS and NATURALLEFTOUTERJOIN shown 
in the example below.

EVALUATE

    VAR _measures = 

        SELECTCOLUMNS(

            INFO.MEASURES(),

            "Measure", [Name],

            "Desc", [Description],

            "DAX formula", [Expression],

            "TableID", [TableID]

        )

    VAR _tables = 

        SELECTCOLUMNS(

            INFO.TABLES(),

            "TableID", [ID],

            "Table", [Name]

        )

    VAR _combined = 

        NATURALLEFTOUTERJOIN(_measures, _tables)

    RETURN

        SELECTCOLUMNS(

            _combined,

            "Measure", [Measure],

            "Desc", [Desc],

            "DAX Formula", [DAX formula],

            "Home Table", [Table]

        )

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

If you run this DAX query, the description (when available), DAX formulae and the home table of all the measures in the model will be displayed:

Documenting your model just got a lot easier.  You may copy the results as you need with the Copy button.  For example, I can go to Model view and 
choose ‘Enter data’ to Paste them into the model.
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I can then add a Report page with a visual showing information about this model:

Here, I have pasted them into Excel and made a Table with CTRL + T:

It should be noted that copy then paste may not work well if you have DAX formulae on multiple lines in your measures.  In that case, you may run 
the DAX query in Excel directly:

	 •	 Open Excel and navigate to the Data tab

	 •	 Click ‘Get Data’

	 •	 Click ‘Database’ in the drop down, then ‘SQL Server Analysis Services’ (not the ‘Analysis Services’ one)

	 •	 In Power BI Desktop, go to Model view, then go to the Data pane -> Model, and click the Semantic model.  If you don’t see this, ensure 	
		  ‘Model Explorer’ is enabled in your Preview features section of Options

	 •	 In the Properties pane, click the copy icon next to Server to add it to your clipboard (another new feature)

		 •	 Returning to Excel, paste the localhost:xxxxx (most likely it will be a different number for you) into the Server

		 •	 You also need the Database, which is not in the Properties pane yet with Server (planned).  You can get the Database ID from an external 	
			  tool, such as DAX Studio, or another free Microsoft tool, SQL Server Management Studio (change Server type to Analysis Services).  The 	
			  database ID is not the name of the PBIX file, but instead a GUID.  If you have previously published the PBIX to the Power BI Service, the 	
			  Database GUID is also in the URL of the published version
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	 •	 Back in Excel, copy in the DAX query to the DAX or MDX query box and click OK

	 •	 Click Load

	 •	 The data will show in an Excel Table.
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What is useful about this approach is you can now refresh it, if you make 
an update to your model during this editing session.  When you close 
Power BI Desktop it will not refresh.  However, if you re-open Power 
BI Desktop, you can simply edit the connection with the new Server to 
refresh it while Power BI Desktop is running.  Also, once published to 
the Power BI Service you may edit the connection’s Server to be the 
Workspace connection and refresh it too.  To change the Server, right-

click the table, click on Table, then Edit Query.  A familiar Power Query 
window will open, and you can update the Server and Database there.  
You can do this with any of your DAX queries, not just these new INFO 
DAX functions.

Another combination that may be useful for the new INFO DAX functions 
is to explore the columns in your model.

DEFINE

    VAR _tables = 

        SELECTCOLUMNS(

            FILTER(

                INFO.TABLES(),

                // Exclude hidden tables

                [IsHidden] = FALSE()

            ),

            "TableID",[ID],

            "TableName",[Name]

        )

    VAR _columns = 

        FILTER(

            INFO.COLUMNS(),

            // Exclude RowNumber columns

            [Type] <> 3

            ) 

    

    VAR _result = 

        SELECTCOLUMNS(

            NATURALINNERJOIN( 

                _columns,

                _tables

            ),

            "Table",[TableName],

            "Column",[ExplicitName],

            "Description",[Description],

            "Column in Data Source",[SourceColumn],

            "Data Category", [DataCategory],

            "Column Type", 

                SWITCH(

                    [Type],

                    1,"Data column", 

                    2, "Calculated column",

                    [Type]

                ),

            "DAX formula", [Expression]

        )

EVALUATE

    _result
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I can take this even further.  I am concerned about the number of calculated columns, so I want to see how many there are and then show only 
calculated columns.  I can do this by adding this to my DAX query:

EVALUATE

    {COUNTROWS(

        FILTER(

            _result,

            [Column Type] = "Calculated column")

    )}

    

EVALUATE

    FILTER(

        _result,

        [Column Type] = "Calculated column")

Changing the DAX query view result grid to the second result, I can see there are six [6] calculated columns:

When I run this DAX query, I can see information about all the columns in my model.  I can see if the name is different than the source name, if they 
have a data category and even the DAX formula for calculated columns.
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It should be noted that the third result shows just the calculated columns:

If you are wondering what the DAX formula for Category (clusters) 2 is, simply hover over it to see the full DAX formula:

As you can see, there are many new ways to explore the metadata of 
your model with these INFO DAX functions.  

You cannot use these functions in calculated tables, calculated columns 
and measures.  They will show an error if you try.  Do note that the INFO 
functions will show in the DAX Formula bar IntelliSense, but they may 
result in an error when used.  If you use them in the DEFINE MEASURE, 
DAX query view will currently still show the Update model CodeLens, but 
it will result in an error when clicked.  These measures can still be run as 
DAX query in DAX query view without error.

To end, you should also notice that there is an update to the Update 
model CodeLens.  Comments are now kept when using the CodeLens 
and the CodeLens will show when the DAX formula formatting has been 
changed.  For example, when you use ‘Quick queries’ to ‘Evaluate and 
define’ a measure, then click ‘Format query’, you will see this update.  
Now, those with new formatting will show a CodeLens to Update model 
to quickly format your measure DAX formulae.

With many of us currently “working from home” / quarantined, there 
are only so Zoom / Teams calls and virtual parties you can make 
before you reach your (data) limit.  Perhaps they should measure data 
allowance in blood pressure millimetres of mercury (mmHg).  To try and 

keep our readers engaged, we will continue to reproduce some of our 
popular Final Friday Fix challenges from yesteryear in this and upcoming 
newsletters.  One suggested solution may be found later in this newsletter.   
Here’s this month’s…

Beat the Boredom Challenge
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Imagine that you need to filter out rows in a table that have specific 
keywords within the text strings contained therein.  Manually filtering 
every single keyword and copying / pasting them to a new location can 
be a tedious and time-consuming process.  To address this, we challenge 
you to develop a user-friendly solution that allows users to select the 

desired keywords and return a list having all the text strings associated 
with those keywords.  

Your aim is to create a filter using the keywords "Awesome", "Amazing", 
and "Perfect" as filter criteria, as shown in the picture below:

As always, there are some requirements:

	 •	 no Power Query / Get & Transform or VBA is allowed

	 •	 the formula(e) should be dynamic so that they shall update when a new entry is added.

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

With Steve Kraynak joining the team, we thought we would exploit his 
knowledge and recant all about Microsoft Excel for Mac.  Each month, 
we’ll cover a different topic to help you understand how Excel for Mac is 

different than Excel for Windows.  This month, we show a few differences 
between the experience of writing formulae on a Mac versus a PC.

Excel for Mac

Thankfully, your formulae will give you precisely the same result on a Mac as they do on Windows.  You don’t need to 
worry about this.  However, there are some minor differences in how Excel helps you to write and edit your formulae. 

[It should be noted that there are a few special functions that only work on Windows.]

When writing a formula, you can begin typing the name of the function you’d like to use, and Excel will show you a list of 
functions that match.  You can use your arrow keys to select a function from the list, and if you’re using Windows, you’ll 
see a helpful ToolTip to show you a short description of the function.  Unfortunately, the ToolTip won’t appear on a Mac. 

As you can see in the examples below, a ToolTip helps you understand the difference between the COUNT and COUNTA functions.  To determine this 
on a Mac, you can use the Formula Builder, which we’ll show next. 

Function ToolTips
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Excel for Mac has a ‘Formula Builder’ pane to help you create formulae.  
This is different than Windows, which has a modal dialog for the same 
purpose. 

It’s a two-step process for a new formula or a single step if you’re editing 
a formula.  To open it, just click the Fx button next to the Formula bar or 
press SHIFT + F3.  At first, it shows the function list.  You can start typing in 
the search field and then select a function from the list to see the function’s 

description and syntax, including the descriptions for each parameter. 

Once you’ve found the function you want, press the ‘Insert Function’ 
button.  The function signature will appear in the pane, showing you 
the parameters with text fields where you can enter the appropriate 
references, functions, and / or values.  When you’re finished, press the 
‘Done’ button and it will insert the formula into the active cell. 

You can use the ‘Formula Builder’ to write and edit, but also to help 
debug your formulae.  When you’ve entered enough information for 
Excel to start calculating, it will show you the current values above each 
field in the pane.   Notice in the example shown above, the ‘Logical_
test’ parameter has a value of TRUE.  This is the current calculation for 

A1=“Month”.  It also shows the result of the entire formula, if it can be 
calculated. Again, in the example above, you can see ‘Result: 12’ near the 
‘Done’ button.  This is the current value being calculated by the formula 
that’s being edited.

Formula Builder

It doesn’t have to be a pane – or a pain.  The ‘Formula Builder’ on a Mac 
will open as a side pane, but you can tear it away from the side and use it 
as a dialog if you like.  This gives you the flexibility to position it anywhere 
you like.  Move it back to the side if you want to dock it later.

Positioning the Formula Builder
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Check back for more details about Excel for Mac and how it’s different than Excel for Windows. 

[It should be noted that the ENCODEURL(), FILTERXML() and WEBSERVICE() functions rely on operating system capability on Windows, so they won’t 
work on a Mac.  You’ll see an #NAME? error and the Formula bar will show the function names with a ‘_xlfn.’ prefix. 

We’ll continue next month…                              

There is a straightforward way of exporting information from Excel to 
PowerPoint.  This method will allow you to link your Excel image in 
PowerPoint back to the source file. 

It is noted that there is a PowerPoint option for a slide layout containing 
text and a chart object.  This is not suitable for pasting an existing Excel 
chart and is only necessary if you wish to use Microsoft Chart for building 

a new graph from scratch.  We will not consider that option here.

Instead, let’s consider an option that will update automatically, to allow 
for new categories, changes in numbers or even a change of chart type.  
The first thing to do is to set up our chart in Excel.  An example could look 
something similar to the following work of fiction:

Next, the chart should be selected and the copied in the usual way e.g. 
click on the chart, right-click and select ‘Copy’.

In PowerPoint, select the slide which will be used to house the graphic 
and then go to the Home tab on the Ribbon and on the Clipboard group, 
select Paste, where there are a few options to choose:

	 •	 Use Destination Theme & Embed Workbook
	 •	 Keep Source Formatting & Embed Workbook
	 •	 Use Destination Theme & Link Data
	 •	 Keep Source Formatting & Link Data
	 •	 Picture.

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we will consider how 
to link charts from Excel to a presentation in PowerPoint. 

Charts and Dashboards
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Choosing ‘Keep Source Formatting & Link Data’ will paste the chart from Excel without changing how it looks and establish the link to the data in the 
Excel file.  Pasting the chart to the PowerPoint slide and click on it, a contextual ‘Chart Tools’ tab will appear on the Ribbon.  Here, the chart can be 
reformatted, and chart data may also be refreshed from the linked Excel file:

Any changes made in Excel will be reflected in this PowerPoint presentation as well, given that the links are not broken.  To edit the links if they break, 
go to the File tab on the Ribbon, and then click on the Info tab:

We can navigate to the bottom right corner to find ‘Related Documents’, then click on ‘Edit Links to Files’:
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A ‘Links’ dialog box will appear, allowing us to make changes or maintain the links if they were to break or the file is relocated.  

More next month.

To maintain good coding practice to declare variables, it is easy to ask 
VBA to force the coder to declare them all the time. This is done using 
the opening statement Option Explicit. 

When Option Explicit appears in a file, you must explicitly declare all 

variables by using the Dim or ReDim statements.  If you try to use an 
undeclared variable name, an error occurs at compile time.

As an example, let’s start with the following code:

The compiler stops with an error alert and snaps back to the Visual Basic Editor to the variable that has not been declared.  The procedure must be 
stopped and the declaration statements added before it will successfully execute.

More next time.

Option Explicit

Sub OETest()

    myTestString = "Hello World!"

    MsgBox myTestString

End Sub

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  This 
month we look at declaring variables.

Visual Basics
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We continue our series on the Excel COM add-in, Power Pivot.  This month, we look at the SEARCH function.

The SEARCH function takes the input text character or text string and looks for it in a data value.  It returns with the character position number of 
where it found within the data value.  SEARCH is case sensitive and looks from left to right.

The SEARCH function uses the following syntax to operate: 

SEARCH(find_text, within_text [, [start_num][, NotFoundValue]])

	 •	 find_text is the text that we wish to find.  Note that we can use the ‘?’ and ‘*’ operators.  The question mark ‘?’ matches any single 	
		  character to the string and the asterisk ‘*’ matches any sequence of characters.  If we wish to find an actual question mark or asterisk, we  
		  have to include the tilde ‘~’ before the question mark or asterisk

	 •	 within_text is the text that we wish to search for find_text, or a column containing text.

	 •	 start_num is an optional input, is the character position in within_text, where we want to start searching
	 •	 NotFoundValue is an optional input; this has to be a number, or we can use the BLANK() function, and it will be returned when the 	
		  operation does not find a matching value. 

Let’s say we want to search for the text “Shoes” in the following data set: 

We can use the following DAX code to search for “Shoes”:

=SEARCH(
	 "Shoes",[Product Type],,
	 0
	 )

Power Pivot Principles
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The SEARCH function returns with the text location of the first instance where it finds “Shoes” in the Product Type text string.  In row 2 it is 10, 
because there are eight characters in “Business”, space “ ” is the ninth character, therefore the 10th character is where the text string “Shoes” begins. 

The current formula has been set to return with zero [0] when no matches are found. 

We can also use the BLANK() function in place of zero:

Notice that our column is not picking up rows 8 and 10.  That’s because the data values in those rows contain “Shoe” rather than “Shoes”.  We can 
adjust our DAX formula to account for this: 

=SEARCH(
	 "Shoe?",[Product Type],,
	 BLANK()
	 )

We included ‘?’ in our find_text term so that we will pick up rows 8 and 10 where it’s “Shoe ” with a space and not “Shoe(s)”.

That’s it for this month; more next time.
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Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we note 
some improvements to Power Query/Get and Transform, in particular looking at how creating a column from examples has developed.

‘Column from Examples’ does appear to keep getting improved.  The good news is that you may now multitask by using this feature, as you can use 
it to combine transformations.  This reminded me of a past problem detailed in this newsletter where we wanted to reformat some names:

My aim was to transform the FULL_NAME field so that we could have ‘C. Parr’ instead of ‘CHRISTINE PARR’.  The problem we came up against 
previously was that ‘Column from Examples’ couldn’t cope (forgive the old Excel 2013 screenshot!):

So, we are going to try that again!

Power Query Pointers

mailto:contact@sumproduct.com
http://www.sumproduct.com
http://www.sumproduct.com/blog


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

In the ‘Add Column’ tab, there is a section called ‘Column from Examples’.  Here, we’re going to allow Power Query to get data for the new column 
‘From All Columns’.

Well this is definitely an improvement!  After two examples, the new column has been created.  We may click ‘OK’ to get my new column:

= Text.Combine({Text.Start([FULL_NAME], 1), ". ", Text.Proper(Splitter.SplitTextByDelimiter(" ", QuoteStyle.None)([FULL_NAME]){1}?)})

Let’s delete this column and try combining data from other columns.  This time, not only do we want to format the name, we also want to include 
the job title and region:
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We create the column to see the full transformation.

= Text.Combine({Text.Start([FULL_NAME], 1), ". ", Text.Proper(Splitter.SplitTextByDelimiter(" ", QuoteStyle.None)([FULL_NAME]){1}?), " (", 
[REP_TYPE_C3], ") ", [AREA_CODE]})

It shows that it’s worth trying out new methods to solve old problems, as Power Query is constantly improving. 

There are also developments in using dates in ‘Column from Examples’ for date formats used in specific domains though we found this functionality 
a bit hit and miss.  Hopefully, it will improve.  We’ve tried it with JOIN_DATE in the following example:

The date is translated to MM-YY from a full datetime format. 

The M formula is

= Text.Combine({DateTime.ToText([JOIN_DATE], "MM"), "-", DateTime.ToText([JOIN_DATE], "yy")})

We can also extract the name of the month:
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We create the new column.

The M formula used is:

= Text.Combine({DateTime.ToText([JOIN_DATE], "MMMM"), " ", DateTime.ToText([JOIN_DATE], "yyyy")})

It’s good to see the functionality is expanding, making ‘Column from Example’ an even more useful feature – especially for beginners.

Until next month.

Unfortunately, the latest set of Power BI updates were announced after our January newsletter had to be prepared.  So apologies for our tardiness, 
but this month’s updates include various updates to reporting (e.g. more options for styling your column and bar charts) and improvements for 
inserting insert Power BI content into your PowerPoint presentations.

The full list of updates is as follows:

Power BI Updates

Reporting

	 •	 On-Object Interaction updates (in Preview)

	 •	 More styling options for Column and Bar charts

	 •	 Extended customisation for data labels

	 •	 Azure Maps clustering aggregation support for bubble layer

	 •	 Alerting on your Power BI reports with Data Activator

Data connectivity

	 •	 OneLake data hub in Power BI Desktop

	 •	 Power BI connector updates

Service

	 •	 Storytelling in PowerPoint: suggested content

	 •	 Ability to search and sort in paginated reports 
 
 
 

Developers

	 •	 Power BI custom visuals authentication API

	 •	 Dynamic drill down API

	 •	 Git integration conflict resolution

Visualisations

	 •	 New visuals in AppSource

	 •	 Activity Gauge by Powerviz

	 •	 Navigate Financial Risks and Rewards with Profitbase’s Power 	
		  BI Visualisation

	 •	 Intuitive multi-level Donut charts for your reports

	 •	 Inforiver Analytics+ 3.2

	 •	 The Microsoft Purview hub in Fabric for creators in Preview

	 •	 VideoPlayer Visual

	 •	 Ridgeline Plot by Powerviz.
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Let’s look at each in turn.

On-Object Interaction updates (in Preview)

NEW ON-OBJECT DEFAULT SETUP

This update sees the introduction of a new default setup that feels closer to the previous classic look.  With this new default, you will be able to 
preset the following options with just one click.  Examples include:

	 •	 Move the ‘Build a visual’ menu to the pane switcher by default

	 •	 Show both Build and Data panes expanded by default

	 •	 Format pane in the pane switcher by default

	 •	 ‘Always open in new pane’ set to on, thereby stacking panes by default

	 •	 Collapse panes to the pane switcher instead of close ‘X’ by default.

Upon updating to the new build, with the new On-Object Preview switch set to ‘On’, you’ll be greeted with a dialog to update to the new default 
setup.  If you like your existing on-object setup and do not wish to have a more classic look, choose ‘Keep setup’ and no changes will be made.
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If you change your mind, you can always go back to the Options menu to customise the experience to your needs.  Here’s a walkthrough of what 
each of these options do:

	 •	 Suggest a type by default: if you prefer the option in the Build menu to be off by default, expanding all the field wells always, make sure  
		  this is not checked

	 •	 In the Build a visual menu, always show all the visualisation types: if you prefer to see all the visualisation types shown by default in the  
		  Build menu, be sure to check this option

	 •	 Always show pane switcher: when checked, this provides the right-hand pane switcher shown even when working with zero panes.  It  
		  provides access to the ‘+’ menu and setting gear always

	 •	 Always show the Build a visual menu in the pane switcher: this moves the Build menu from showing next to the visual, to the pane  
		  switcher on the right side instead.  Check this option if you prefer to work with the Build menu as a pane

	 •	 Always open a new pane: instead of switching between panes, check this option if you prefer the stacking behaviour as before.  With this  
		  option on, opening a new pane will open side-by-side by default.

To summarise, here’s the state of these settings for the new default setup:

MULTI-SELECT IN DATA FLYOUT

To cut down on the extra clicks when first adding data using the new ‘add 
data’ button, the data flyout now allows you to multi-select fields to add 
fields in bulk to your visual, just like the Data pane.  Simply check all the 
fields you’d like to add to your visual in one go.

This works best when ‘suggest a type’ is switched to ‘on’ so you can 
add as many fields as you like and Power BI will place the fields in the 
appropriate field wells for you.
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IN-PRODUCT USER EDUCATION

With the many changes the On-Object interaction introduced, it can hard to know where certain features may have moved.  This month, four [4] 
teaching bubbles have been added to help users along the way.

Question Answer

Where is the Drillthrough and ToolTip page set up? A teaching bubble will now point to the new location within Format -> Page 
information.

Where did the Analytics pane go? Analytics options like error bars, max, min or percentile lines are now consolidated in 
the Format pane at the bottom.  You can set a max, min or other reference line using 
the new ‘Reference line’ card in the Format pane.

What happened to the right click options for a field 
like ‘rename’ or ‘show value as’?

They are still available on the right click.  Simply right click on the field name to see the 
same options as before.

How do you bring back the Data pane if the pane 
switcher is gone?

You shouldn’t run into this as frequently now that the behaviour has been updated to 
collapse panes by default instead of closing.  However, in case you do, you can always 
re-open a pane from the View tab in the Ribbon.

More styling options for Column and Bar charts

This update sees many new formatting enhancements for Column and Bar charts in Power BI.  These additions are designed to improve your data 
visualisation, enabling more impactful analysis and storytelling capabilities. 
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Key enhancements include: 

	 •	 Apply settings to All or Series: you may now apply formatting options globally across all categories or tailor them for each unique 	
		  individual series 

	 •	 Transparency Control: you can now adjust the fill colour transparency to achieve a better balance of visibility and design

	 •	 Border customisation: you can now introduce borders with precision, choosing a distinct colour or match it to the column’s fill, and 	
		  define both the border’s width and transparency for a more polished look

	 •	 Layout: the Spacing card has been renamed the Layout card.  This update also has relocated the familiar ‘Reverse Order’ toggle that 	
		  allows you to invert series, and introduced ‘Sort by Value’, ‘Space between categories’ and ‘Space between series’.  Furthermore, with 	
		  Clustered columns and Bar charts, you now have the option to Erode or Explode the Stacked series

	 •	 Advanced Ribbon settings: you can highlight a series or create visual continuity with an array of options including matching series colour 	
		  or choosing a colour selection, transparency, border colour matching or colour selection, border width and border spacing. 

These features aim to provide you with greater flexibility and creative freedom in presenting your data, ensuring that your insights stand out more. 

Extended customisation for data labels

Azure Maps clustering aggregation support for bubble layer

Data labels are also getting more options too.  With this update, there are now some new enhanced capabilities for Data labels, giving you extended 
customisation choices.  Further, it brings the simple integration of additional metrics, dramatically improving your data analysis experience.  

Microsoft has introduced an enhancement to the Power BI Azure Maps 
visual: the clustering aggregation feature for the bubble layer with 
customisable styling options.  This capability not only enables you to 
dynamically aggregate data within bubble layers based upon distinct 
zoom levels, but also allows you to tailor the visual representation of 
clustered data.

You may now style your cluster bubbles, choosing from a range of 
options including bubble colours, font size and more.  This level of 
customisation assists you with visually highlighting and emphasising 
specific aspects of the data, creating more impactful and informative 
geospatial visualisations.  

 Key updates include:

	 •	 Title: The new Title card feature enables the display of legend fields on your data labels, offering the option to omit the legend for a  
		  cleaner look.  It also allows customised data label titles using different data fields, adjustable font style, colour and transparency

	 •	 Value: you can now easily spot the active field for your data label in the field well.  Modifying it to another field is quick and easy, with  
		  customisation options like font, colour, transparency and more, plus a new feature for blank value display

	 •	 Detail: The new Detail card feature unlocks new potential by allowing the inclusion of a secondary metric to your data labels.  You may  
		  choose any field to add an extra value, with plenty of formatting options at your disposal

	 •	 Visual label layout: this is a new feature that lets you choose between a single-line data label or a multi-line data label, where desired. 

These features are available for Columns, Bars, Lines and Ribbon charts.  
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Alerting on your Power BI reports with Data Activator

Back in October, Microsoft announced the public Preview of Data Activator.  Many Power BI users have since been asking for alerting capabilities 
within reports.  From the visual context menu or Report toolbar you can choose ‘Set alert’.  This opens a pane where you may set the measure you 
want to monitor and the conditions you wish to detect:

When you select Continue, it will create a Data Activator reflex and connect it to the data in your Power BI dataset.  Data Activator will automatically 
start monitoring your data and notify you when the condition is met.
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OneLake data hub in Power BI Desktop

INWINK (NEW CONNECTOR)

STARBURST ENTERPRISE (CONNECTOR UPDATE)

Connectivity to Fabric items (Datamarts, Lakehouses, Warehouses, KQL Databases) via the OneLake data hub is now Generally Available, following 
the earlier announcement of Fabric’s General Availability.

This update witnesses the release of the inwink connector.  You may 
now visualise your inwink data and create dashboards using the inwink 
connector for Power BI.  Further, you may combine data in inwink 

with data from other business  apps (like Salesforce, SAP, etc.) to drive 
better decision making and analyse the performance of your events  
and communities.

The Starburst Enterprise connector has been updated. All changes are backwards compatible:

	 •	 added support for cancelling queries using ‘CancelQueryExplicity’

	 •	 added ‘Use default proxy’ checkbox

	 •	 added support for Starburst Galaxy OAuth authentication

	 •	 removed ‘Safe metadata read (optional)’ from the connector dialog.  It is now enabled by default for all queries.

Power BI connector updates

AMAZON ATHENA (CONNECTOR UPDATE)

The Amazon Athena connector has been updated.  In this Power BI connector release, it has eliminated an issue that prevented users from connecting 
to Athena using AAD authentication without a role parameter.

BQE CORE (CONNECTOR UPDATE)

The BQE Core connector has been updated.  It has now added ‘Target Utilization’ and ‘Birth Date’ properties to the Employee table.

DATABRICKS (CONNECTOR UPDATE)

The Databricks connector has been updated.  In this release, AAD authoring support has been added for Databricks AWS workspace.
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SNOWFLAKE (CONNECTOR UPDATE)

EDUFRAME REPORTING (CONNECTOR UPDATE)

Storytelling in PowerPoint: suggested content

The Snowflake connector has been updated to enable cancellation of a Snowflake query when the operation is cancelled in the Power BI user 
interface.

The Eduframe Reporting connector has been updated.  Modifications include:

	 •	 added teacher enrolments

	 •	 added teacher roles

	 •	 added catalog variants

	 •	 added planning event materials

	 •	 added meeting materials

	 •	 fixed the loading of teachers.

This update sees a new feature, a Power BI add-in for PowerPoint that 
makes it easier to find and insert the Power BI reports you need for your 
presentation.

When you add the Power BI add-in to your slide, the add-in automatically 
scans the title of the slide and suggests Power BI content that might be 
relevant.  For example, if the title of your slide is “Holiday campaign 
status”, the add-in will show you a list of Power BI reports that contain 
data about campaigns.

The add-in also shows you reports you’ve recently visited in Power BI, so 
you can easily access reports you’re working on or frequently use.

It should be noted that if the report you wanted to add doesn’t appear 
in the list of suggestions, you can just copy the report’s URL and paste it 
into the input box, as you’ve always done.

Once you find the report you want to insert, you can choose to insert a complete page or a specific visual from the report.  You can also update filters 
or slicers before you insert your selection.  Filter and slicer values are saved together with the report or visual you picked.

If you have permission to grant others access to this report, you can also select the ‘Give people automatic access to this data’ checkbox, so that 
when others in your organisation view this presentation, they’ll be able to see the data you’ve just added to the slide.
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Ability to search and sort in paginated reports

Power BI custom visuals authentication API

Dynamic drill down API

Git integration conflict resolution

This update introduces the ability to search for content across all pages of a paginated report in the Power BI Service.  The paginated report can 
either be published to the Service or can be authored on the Power BI Service.  You may specify any required parameters to view the report before 
searching.  The search works across all pages of the report.

This API allows Custom Visuals to obtain Azure Active Directory (AAD) access tokens through single sign-on (SSO), facilitating secure and efficient 
user-contextual operations.  The API will be controlled by a global administrator setting.

This feature allows the visual to enable or disable the drill feature dynamically using an API call.

When the drill feature is enabled, all the functionalities of drilldown and expand / collapse features are available.  These functionalities include API 
calls, context menu commands, header drill buttons and support for hierarchy data.  When the drill feature is disabled, these functionalities aren’t 
available.  I would never have figured that.

When working with Git integration in Fabric, conflicts may occur if the same items are edited in both the Fabric workspace and in the connected Git 
repository.  To avoid any mistakes, items in conflict are marked as such, and the conflicts must be resolved before any further changes can be made.  
In these cases, it is up to you to decide which changes to keep and which to discard.

You can also sort on a column by simply clicking on the sort icon when the report is rendered in the Power BI Service.

It should be noted that both sort and search are available only in the Web layout.
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To make things easier, Microsoft has added the option to resolve conflicts 
and select which content to keep directly within the Fabric workspace, so 
that you don’t have to navigate elsewhere or revert to previous versions.

Accessed by updating items from the ‘Source control’ pane, resolving 
conflicts is as simple as selecting whether to accept incoming changes or 
keep the current content for each item in conflict.  Once the selections 

are made, all items may be merged and updated, and any further 
changes can be made in the workspace.

Resolving conflicts can also be undertaken by reverting either the 
workspace or the Git branch to a previous state, or directly in Git if you 
need to further inspect what changes were made and which version to 
choose.

New visuals in AppSource

This month’s new visuals include:

	 •	 Risk Matrix by Profitbase

	 •	 PowerBI User Activity Tracker

	 •	 ilionx ZorgControl KPI Gauge

	 •	 Tabulator for PowerBI

	 •	 Funnel Charts.

Activity Gauge by Powerviz

The Activity Gauge by Powerviz is a visual used to measure the progress against a set target or goal for multiple categories.  It is typically presented 
in the form of a Radial Bar chart / gauge, displaying a range of values or percentages.  This visual is commonly used for project management, 
performance tracking and monitoring Key Performance Indicators (KPIs).
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Key features include:

	 •	 Gauge customisation: shape, style and add icons for a unique design
	 •	 Targets: choose from options or use a custom field to set a target

	 •	 Data colours: offers seven [7] schemes and 30+ colour palettes

	 •	 Centre circle: customise the centre circle with text, icons, measures and images

	 •	 Interactive mouseover: hover for ‘Interactive Info Display’
	 •	 Conditional formatting: create rules based upon measure or category rules.

Other features included are ranking, annotation, grid view, show condition and accessibility support.

Business use cases might include:

	 •	 Project management: track task progress for efficient management

	 •	 Financial dashboard: gain insights into key financial metrics

	 •	 Employee performance: evaluate contributions and identify areas for improvement.

Activity Gauge is available in AppSource.

Navigate Financial Risks and Rewards with Profitbase’s Power BI Visualisation

Profitbase’s new Risk Matrix visualisation for Power BI provides businesses with a better way to visualise and assess potential risks.  This helps 
them handle and minimise potential damage, in addition to discovering opportunities that the business may benefit from.

Advantages of the Risk Matrix by Profitbase:

	 •	 Efficient risk assessment: evaluate risks by impact and likelihood

	 •	 Focused prioritisation: spotlight and tackle high-priority risks, focusing your resources effectively
	 •	 Strategic allocation: employ the tool to guide resource distribution

	 •	 Harmonised communication: establish a common understanding among teams and stakeholders

	 •	 Flexible customisation: personalise the matrix size, from 5×5 to 3×3 or 3×5, and colours may be changed to align with your company’s 	
		  branding

	 •	 Dynamic visualisation: adjustable bubble sizes animate your data, offering a clear financial perspective.
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Intuitive multi-level Donut charts for your reports

Inforiver Analytics+ 3.2

Drill Down Donut PRO for Power BI allows you to use multi-level Donut (Doughnut) charts.  All interactions take place as on-chart interactions, 
ensuring a quick and easy data exploration experience.  You can control every aspect of the chart through various customisation and also select from 
multiple chart types (Donut, Pie, Gauge).  Drill Down Donut PRO is available from AppSource.

Main features:

	 •	 Adjustable ‘Others’ slice: set the number of visible slices and group the rest

	 •	 On-chart interactions: no need to learn hidden controls
	 •	 Custom ToolTips: select ZoomCharts custom ToolTip or Power BI’s built-in ToolTip

	 •	 Full customisation: you may modify every slice, label and legend

	 •	 Desktop and mobile device navigation: explore charts the same way on any device.

Popular use cases include:

	 •	 Sales and marketing: measuring campaign performance and research results

	 •	 Human resources: staff composition, salary distribution, performance data

	 •	 Accounting and finance: income and expense analysis, billings, creditors and debtors

	 •	 Project management: risk distribution, resource allocation.

Inforiver Analytics+ (50+ charts, cards and tables) by Lumel is now a complete No-Code storytelling visualisation platform that is designed to help 
customers migrate legacy dashboards from Tableau, Spotfire, Qlik, Cognos, SAP Lumira or their static PowerPoint dashboards from Think-cell or 
Mekko Graphics and consolidate them within Microsoft Power BI.

Benefits include:

	 •	 Small Multiple and Trellis, similar to Tableau and Spotfire

	 •	 “Visual PivotTable” for hierarchical data on all three axes (x, y and z) like Spotfire

	 •	 split and group measures into Trellis panels like Tableau

	 •	 storytelling features like Think-cell and Mekko Graphics:

			   ○	 Dynamic Deviations (CAGR)

			   ○	 Annotations

			   ○	 Series connector lines

			   ○	 Automatic series and categorical sorting

	 •	 Trellis Tables with Excel-like formatting

	 •	 Advanced visualisations:

			   ○	 Box and Whisker Plot: dynamic and pre-calculated quartiles

			   ○	 Marimekko Chart (variable width Column or Cascade chart): stacking and 100% scales

			   ○	 Advanced Waterfall: measure-based Interim, Stacked & Dual Breakdown, Variance and Combination

	 •	 Special Charts for Story Telling:

			   ○	 Slope graph

			   ○	 Lollipop and Dumbbell

			   ○	 Dot Plot,

			   ○	 Arrow & Range Plots.

Multivariate visualisations (Bubble / Scatter and Radar / Polar) and Pie / Donut types will be added to this visual soon.
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The Microsoft Purview hub in Fabric for creators in Preview

VideoPlayer Visual

The Microsoft Purview hub is a centralised page in Fabric that helps 
Fabric administrators and users gain insights about their Fabric data 
estate.  It contains reports that provide insights into sensitive data 
and item endorsement and serves as a gateway to more advanced 

capabilities in Microsoft Purview.  Following the public Preview release 
of the Microsoft Purview hub for Fabric tenant admins back in May 2023, 
the hub is now available in public Preview for all Fabric users.

The VideoPlayer visual for Power BI Desktop has now joined us.  This new custom visual allows you to integrate videos into your Power BI reports, 
enhancing your data storytelling capabilities.  With VideoPlayer, you can enrich your reports with dynamic multimedia content to engage your 
audience effectively.

Key features:

	 •	 video integration: easily embed videos from various sources, such as YouTube, Vimeo (including password protected videos) and many  
		  others, directly into your Power BI reports

	 •	 interactive playback: control video playback using intuitive play, pause and seeking functionality, ensuring your audience can interact 	
		  with the content as needed

	 •	 customisation: modify the appearance of the VideoPlayer to match your report’s style and design, including changing the video player’s 	
		  dimensions and controls

	 •	 data-driven video selection: utilise data-driven techniques to determine which video to play based on your dataset, making your reports 	
		  more insightful.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Ridgeline Plot by Powerviz

A Ridgeline Plot or Joy Plot is an advanced Power BI visual that visually represents numerical variable distributions across multiple categories on a 
continuous axis.  The overlapping mountain ranges allow simple comparison.  Ridgeline Plot effectively highlights patterns of distribution change 
across different categories, providing insights into the variability and trends within the data.

Key features include:

	 •	 multiple distribution: ability to plot more than one value in measures

	 •	 Ridge style: different lines and marker styles available

	 •	 scaling: control y-axis scaling and overlaps
	 •	 colours: apply colour schemes across x-axis, y-axis and based upon FX rules
	 •	 ranking: filter Top / Bottom N values, with “Others”
	 •	 reference line: highlight ranges or important data points on x and y axes
	 •	 mode line: emphasise peak points and display labels

	 •	 custom ToolTip: add highest, lowest, mean and median points without any DAX
	 •	 themes: save designs and share with JSON files.

Other features included are ranking, annotation, grid view, show condition and accessibility support.

Business use cases might include time series data, statistical analysis and data distribution. 

You can download Ridgeline Plot for free from AppSource.
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More next month.

Sadly, it’s all quiet on the Excel front this month, but don’t fret.  We’re sure it will be back with a vengeance next month.  In the meantime, 
just to keep you apprised here is the latest version of the grid with all the new features.  Nonetheless, you can find the interactive links at  
aka.ms/ExcelFeaturesFlyer. 

New Features for Excel
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The A to Z of Excel Functions: MINUTE

Back next month, we’re sure.

This function returns the minutes of a time value (expecting a serial number). The MINUTE is given as an integer, ranging from zero [0] to 59.  The 
MINUTE function employs the following syntax to operate:

MINUTE(serial_number)

The MINUTE function has the following argument:

	 •	 serial_number: this is required and represents the time that contains the minute you want to find.  Times may be entered as text strings 	
		  within quotation marks (e.g. "6:45 PM"), as decimal numbers (for example, 0.78125, which represents 6:45 PM, or as results of other 	
		  formulas or functions (for example, TIMEVALUE("6:45 PM")).

It should be further noted that: 

	 •	 time values are a portion of a date value and are represented by a decimal number (e.g. 12:00 PM is represented as 0.5 because it is half 	
		  of a day).
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Please see some examples below: 

In mathematics, especially in areas such as linear algebra, matrices may be used to solve simultaneous equations.  For the record, a matrix is not just 
a movie it’s a rectangular arrangement of m x n elements, in the dimensions of m rows by n columns, e.g. a matrix A (say) may be represented as

It is often written in compact form as

The A to Z of Excel Functions: MINVERSE
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An n x n square matrix A is called invertible (also non-singular or non-
degenerate), if there exists an n x n square matrix B such that

AB = BA =In

where In denotes the n x n identity matrix and the multiplication used 
is ordinary matrix multiplication.  If this is the case, then the matrix B 
is uniquely determined by A, and is called the (multiplicative) inverse 
of A, denoted by A−1.  Matrix inversion is the process of finding the 
matrix B that satisfies the prior equation for a given invertible matrix A. 

A square matrix that is not invertible is called singular or degenerate.  A 
square matrix is singular if and only if its determinant is zero.  Singular 
matrices are rare in the sense that if a square matrix's entries are 
randomly selected from any finite region on the number line or complex 
plane, the probability that the matrix is singular is zero [0], that is, it will 
"almost never" be singular.  Non-square matrices (m x n matrices for 
which m ≠ n) do not have an inverse.  However, in some cases such a 
matrix may have a left inverse or right inverse.  If A is m x n and the rank 
of A is equal to n (n ≤ m), then A has a left inverse, an n x m matrix B such 
that BA = In.  If A has rank m (m ≤ n), then it has a right inverse, an n x m 
matrix B such that AB = Im.

The Excel function MINVERSE returns the inverse matrix for a matrix stored in an array.  It has the following syntax:

MINVERSE(array)
where:
	 •	 array is required, and represents a numerical array with an equal number of rows and columns.
It should be noted that:
	 •	 array may be given as:
			   ○	 a cell range, e.g. A1:C3
			   ○	 an array constant, such as {1,2,3;4,5,6;7,8,9}
			   ○	 a name to either of these

	 •	 MINVERSE returns the #VALUE! error when:
			   ○	 any cells in array are empty or contain text
			   ○	 array does not have an equal number of rows and columns
	 •	 matrix determinants are generally used for solving systems of mathematical equations that involve several variables
	 •	 MINVERSE is calculated with an accuracy of approximately 16 digits, which may lead to a small numeric error when the calculation is not 	
		  complete.  For example, the determinant of a singular matrix may differ from zero by 1E-16
	 •	 some square matrices cannot be inverted and will return the #NUM! error value with MINVERSE.  The determinant for a non-invertible 	
		  matrix is zero [0].

If you have a current version of Microsoft 365, then you can simply enter 
the formula in the top-left-cell of the output range, then press ENTER to 
confirm the formula as a dynamic array formula.  Otherwise, the formula 
must be entered as a legacy array formula by first selecting the output 

range, entering the formula in the top-left-cell of the output range, and 
then pressing CTRL + SHIFT + ENTER to confirm it.  Excel inserts curly 
brackets (“braces”) at the beginning and end of the formula. 

As an example:

The A to Z of Excel Functions: MIRR
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The Internal Rate of Return (IRR) is the name given to the discount rate that makes the Net Present Value (NPV) of a range of cashflows zero.  For 
example, if I invest $100 now and receive $121 back in two years’ time this would give me an annual IRR of 10% since:

	           ($100) + PV($121) = ($100) + $121 / (1 + 10%)2 

				   = ($100) + $100

			       NPV	 = 0

It is often used to calculate cost of capital hurdle rates, bond rates, discount rates implicit in leases and Compound Annual Growth Rates, amongst 
other tasks.  

Excel has two functions that estimate IRR:

	 •	 IRR(values, [guess]) returns the periodic IRR for a set of sequential cashflows occurring on a regular periodic basis.  There must be at least  
		  one positive and one negative value in the range.  IRR will then cycle through an iterative technique (up to 20 times) to try and find an	
		   answer which is accurate to within 0.00001%

	 •	 XIRR(values, dates, [guess]) returns the annual IRR (assuming a 365-day year) for a set of cashflows which may neither be sequential nor 	
		  occur on a regular periodic basis.  Again, there must be at least one positive and one negative value in the range.  XIRR will then cycle 	
		  though a similar iterative technique (this time up to 100 times) to try and find an answer which is accurate to within 0.000001%

	 •	 if the guess is not specified, Excel will assume that it is 10% (0.1) for both functions

	 •	 watch out with XIRR: in Excel 2003 and earlier versions it is found in the Analysis ToolPak (go to Tools -> Add Ins… or ALT + T + I).  If the 	
		  ToolPak has not been added in, using XIRR in a formula will give rise to the #NAME? error.  If this applies to you, it’s really time to invest 	
		  in some new software.

Both are fraught with problems in practice and the associated Excel file provides several documented examples.  However, before we discuss some 
of the problems with the functions, let me compare and contrast with a simple example:

In the illustration above, we consider three slightly different cashflows.  
The first one has the old faithful “hockey stick” projections of an outflow 
followed by five successive cash inflows.  In our example, this would give 
us a periodic IRR of 1.64%.  If the periods were months and we wished 
to convert this to annual rate then, using the compounding formula, this 
would be:

(1 + 1.64%)12 -1 = 21.54%.

The second example for IRR gives the same rate – which is correct.  Start 
dates for IRR are irrelevant: the only thing that matters is how long after 
the initial cashflow subsequent flows occur.

Unfortunately, the third scenario is not right and demonstrates a 
weakness in the IRR function.  Here, the outflow still occurs in the first 
period, but then there is a two-month delay before the inflows are 
received.  Clearly, this will impact both the NPV and the IRR.  The IRR is 
unaffected however – because blanks are ignored by the IRR function.  
To get Excel to calculate the IRR correctly here, zeroes should be entered 
into the two blank cells.

The XIRR function uses the same three cashflow scenarios and 
calculates correctly for the first and third scenarios.  They demonstrate 
what happens when cashflows are aperiodic.  For example, in the first 
scenario, instead of an annual IRR of 21.54% (as calculated above) we get 
2.77%, reflecting the irregular payment profile.

The second scenario should be different now too, as the timing of the 
cashflows is different.  The rate cited is 0.00%.  This means that with no 
discounting the NPV should be zero, i.e. the numbers should add up to 
zero.  They do not: the sum is actually $2,325.05 and there is a clue in the 
number formatting as to what is going on here.

Every time a cashflow series changes sign (i.e. goes from positive to 
negative or vice versa) there is potentially another solution to the 
Internal Rate of Return (IRR).  Consider the following:
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Here, prompted by a guess in the XIRR function (albeit of the other 
solution 21.43%), the two common Excel functions XIRR and IRR return 
the two IRRs associated with this cashflow scenario.  It is important to 
not only check that an IRR gives an NPV of zero but that it is also the 
correct one in the circumstances.

This is the first problem with the concept of IRR.  However, before 
we look at an objective way to generate just one meaningful solution 
for analysis, I’d like to consider another key issue.  Forget the almost 
nonsensical IRR of 970.86% quoted in the above example.  The other 
solution, 21.43%, seems more “realistic”, yes?

As explained in the previous section, the Internal Rate of Return (IRR) is 
the name given to the discount rate that makes the Net Present Value 
(NPV) of a range of cashflows zero.  For example, if I invest $100 now 
and receive $121 back in two years’ time this would give me an annual 
IRR of 10% since:

	           ($100) + PV($121) 	 = ($100) + $121 / (1 + 10%)2 

				    = ($100) + $100

			        NPV	 = 0

It is nothing more than this.  Put simply, if all cash required is borrowed 
at 21.43% and all surplus cash is reinvested at 21.43%, my project would 
neither create nor destroy cash value.

Wait a minute.  Reinvest at 21.43%..?  If I could find a risk-free investment 
returning this sort of money I would be depositing my pension in it never 
mind stakeholders’ funds.  The symmetry of the finance rate (cost of 
borrowing, typically the Weighted Average Cost of Capital) and the 
reinvestment rate (the return surplus funds can generate) is usually an 
absurd notion in the real world: if gains could be made in a free market, 
the principle of arbitrage would soon erode this advantage. 

If we are looking for a measure to address the multiple solutions issue 
of IRR, perhaps we should also ensure it considers the fact that finance 
rates tend to be greater than reinvestment rates.

This is where we now use the 

Modified Internal Rate of Return (MIRR).  To explain how this works, I 
will be using the following example, which is included in the associated 
Excel file.

Consider the following assumptions:

Let’s keep this example nice and simple.  Here, I have assumed a finance 
rate of 12%, a reinvestment rate of a more realistic 8% (say) and cash 
flows generated periodically at 11 points of time (Time 0 being “now” 

to Time 10 being 10 periods from “now”).  Notice that the cash flows 
change sign a total of five times, which means there could be potentially 
five different IRRs.
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This is the reason for the “Guess” cell (G16) in the illustration above.  The IRR formula in cell G24 is

=IRR(H22:R22,Guess)

where changing the value of Guess may cause the IRR calculated to vary (i.e. generate an alternative solution).

The MIRR calculation (cell G25) is simply

=MIRR(H22:R22,Finance_Rate,Reinvestment_Rate)

where the Finance_Rate is entered in cell G13 and the Reinvestment_Rate is entered in cell G14.  The formula for MIRR is defined as follows:

where:
	 •	 NPV() is the Excel NPV function

	 •	 rrate is the reinvestment rate

	 •	 frate is the finance rate

	 •	 values[positive] is the positive values in the array only

	 •	 values[negative] is the negative values in the array only

	 •	 n is the number of periods.

This formula will always give the same value regardless of the number of changes of sign in the cash flow.  It also takes into account the disparity 
between reinvestment and finance rates.  It ticks the boxes – the only question is: what on earth does it do?

It’s quite simple actually in concept.  Let’s ignore the formula and perform the calculation manually with the example above.

The first problem we have is the number of sign changes (five). To get an objective measure, we need just the one change of sign to ensure a unique 
solution.  How do we do that?

To begin with, the cash flows should be split in two as follows:

The associated Excel file clearly shows how this breakdown was arrived 
at using MAX() and MIN() functions.

The intention now is to replace the values in one or both rows by an 
equivalent single positive or negative number.  This is not simply the 
summation of the rows as this does not take into account the time value 
of money (e.g. $100 reinvested would be worth $108 = $100 x (1 + 8%) in 

the next period using the above assumptions).

To work out what the discount factor should be, we need to determine the 
appropriate rate (finance rate for negative cash flows and reinvestment 
rate for positive cash flows) and at what point in time the cash flows are 
to be collated.  We do this using the following table:

The Finance Rate calculates the appropriate discount factor required to generate the present values for Time 0 (i.e. the value of all negative cash 
flows as if they had arisen in the first period).  This is because for most projects, companies will invest first (negative cash flows in early periods) to 
receive positive cash flows in later periods.

For example, the Time 2 factor (0.797, cell J33) is calculated as 1/1.122, i.e. discounting for two periods at the finance rate of 12%.
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The Reinvestment Rate calculates the appropriate discount factor 
required to generate the present values for the final period (here, 
Time 10 or the 11th period) (i.e. the value of all positive cash flows as if 
they had arisen in the last period).  As before, this is because for most 
projects, companies will invest first (negative cash flows in early periods) 
to receive positive cash flows in later periods – including the final period.

For example, the Time 7 factor (1.260, cell O34) is calculated as 1.083, 
i.e. inflating for three periods (= 10 – 7) at the reinvestment rate of 8%.

Now, we simply cross-multiply the discount factors (rows 33 and 34 in 
our example) by the split cash flows (rows 40 and 41), viz.

The negative numbers after Time 0 become smaller (reflecting the discounting), whereas positive cash flows are increasingly inflated the earlier 
they are to the final period (Time 10).

We now have three alternative cash flows we can consider:

	 1.	 aggregate the investment (negative) cash flows only;

	 2.	 aggregate the returns (positive cash flows) only;

	 3.	 aggregate both the investment cash flows and the returns.

Each of these options will only create one change of sign and consider the disparate discount rates.  I now consider each one in turn.

1. Aggregate the Investment (Negative) Cash Flows Only 

2. Aggregate the Returns (Positive Cash Flows) Only 

The associated Excel file calculates the following cash flow:

The following cash flow may be calculated:

Row 85 shows a negative cash flow in the first period (being the sum of row 47) with non-negative cash flows thereafter (from row 41).  Having zero 
in a period does not constitute a change of sign, but these cells must be zero rather than blank else the Excel functions will not calculate correctly.

Note that whilst the IRR changes slightly from the original calculation, the MIRR is precisely the same.  This IRR is unique (only one change of sign).

Row 96 shows several negative cash flows (referenced to row 40) with a non-negative cash flow in the final period (being the sum of row 48).  

Note that again the IRR changes from the original calculation (it is reduced since all positive cash flows have been moved to the final period), the 
MIRR is precisely the same.  As before, this IRR is unique (only one change of sign).
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3. Aggregate Both the Investments and the Returns (MIRR Approach) 

This is the first cash flow shown in the Outputs section of the associated Excel file:

Row 73 contains only two non-zero flows: the present value of all investments at Time 0 and the future value of all returns At Time 10.  As before, 
for this to work correctly, the interim period cash flows must be zero rather than blank.  

As above, the IRR will be unique, but this time the IRR equals the MIRR.  This is how the MIRR is calculated.  Indeed, cell G77 contains an alternative 
method of calculation, the “Exponential Growth” approach, calculated as:

=(32,366/12,701)1/10

This is essentially the MIRR formula from earlier:

Using the formula, MIRR is arguably quicker to calculate than IRR, more 
objective (only one solution) and takes into account the differing rates 
implicit in the cash flows.  MIRR is usually lower than IRR (assuming 
the reinvestment rate will be lower than the finance rate), unless the 
reinvestment rate equals the finance rate, whereby altering the cash 
flows as depicted above will neither affect the NPV nor the IRR.

The MIRR is often seen as a financial measure of an investment's 
attractiveness.  It is used frequently in capital budgeting to rank 
alternative investments of similar size (although this may not always 
be an appropriate approach: NPV or NPV per $ invested (the so-called 

“bang for buck” key factor analysis) may be more suitable metrics).

There is much confusion about what the reinvestment rate implies.  
However, both the NPV and the IRR techniques assume the cash flows 
generated by a project are reinvested within that same project. This is 
not always the case; often, they are often reinvested elsewhere within 
the business and it is not a necessary assumption that the firm is capable 
of generating that IRR elsewhere.  Indeed, one implication of the MIRR is 
that the project is not capable of generating cash flows as predicted and 
that the project’s NPV is overstated.  

In mathematics, matrix multiplication is what’s known as a binary operation that produces a matrix from two matrices.  For matrix multiplication, the 
number of columns in the first matrix must be equal to the number of rows in the second matrix.  The resulting matrix, known as the matrix product, 
has the number of rows of the first and the number of columns of the second matrix, i.e.

The A to Z of Excel Functions: MMULT
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Algebraically, if A is an m x n matrix and B is an n x p matrix, w

then the matrix product C = AB is determined to be the m x p matrix

i.e.

The Excel function MMULT returns the matrix product of two arrays, array1 and array2 (the Excel equivalent of a matrix).  The result is an array with 
the same number of rows as array1 and the same number of columns as array2.

It has the following syntax:

MMULT(array1, array2)

where:

	 •	 array1 and array2 are required, and represent the two arrays you wish to multiply.
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It should be noted that:

	 •	 as explained above, the number of columns in array1 must be the same as the number of rows in array2, and both arrays must contain 	
		  only numbers
	 •	 array1 and array2 may be given as cell ranges, array constants or references
	 •	 MMULT returns the #VALUE! error when:
			   ○	 any cells are empty or contain text
			   ○	 the number of columns in array1 is different from the number of rows in array2
	 •	 The matrix product array, a, of two arrays, b and c, is:

If you are using Microsoft 365, then you can simply enter the formula in the top left cell of the output range, then press ENTER to confirm the formula 
as a dynamic array formula.  Otherwise, the formula must be entered as a legacy array formula by first selecting the output range, entering the formula 
in the top-left-cell of the output range, and then pressing CTRL+SHIFT+ENTER to confirm it.  Excel inserts braces (curly brackets) automatically.

As examples:

where i is the row number and j is the column number.

Legacy Approach

Using Dynamic Arrays

More Excel Functions next month.
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This month, we asked you to imagine that you needed to filter rows in 
a table that have specific keywords within the text strings contained 
therein.  Manually filtering every single keyword and copying / pasting 
them to a new location would be a tedious and time-consuming process.  
To address this, we challenged you to develop a user-friendly solution 

that allows users to select the desired keywords and return a list having 
all the text strings associated with those keywords.  

Your aim was to create a filter using the keywords "Awesome", 
"Amazing", and "Perfect" as filter criteria, as shown in the picture below:

As always, there were some requirements:

	 •	 no Power Query / Get & Transform or VBA was allowed

	 •	 the formula(e) should be dynamic so that they should update when a new entry was added.

Suggested Solution

The steps are detailed below.

Beat the Boredom Suggested Solution

Find the keywords

To begin, we create three [3] new columns in the Data Table (CTRL + T) with the heading names based upon the keywords provided:

We accept this is a manual interaction as Table headers may not contain 
formulae.  

To check whether the  text strings  in the Data[Teams] column have 
specific keywords, we need to create a formula that uses the ISNUMBER 
and SEARCH functions.  These functions work together to confirm the 
keywords are within the text strings (note that the FIND function could 
also be used, but beware that it's case-sensitive and requires an exact 
match between the capitalisation of the keywords and text strings).

=ISNUMBER(SEARCH(Data[[#Headers],[Awesome]],[@Teams]))*1

The SEARCH function will return a number if the keywords is found 

within the text string.  If the text string did not contain the keyword, 
then it will return #VALUE!.  Then the ISNUMBER checks whether the 
output of the SEARCH function is a number or not and will return TRUE 
or FALSE accordingly.  At this point, we can choose to keep it as logical 
value or turn it into number.  We will change all these logical values into 
numbers, so we multiply the numbers by one [1].  Therefore, all TRUE 
values will be restated as one [1] and all FALSE values will turn to zero [0].  
Similarly, we will do the same for the other two [2] columns, viz.

=ISNUMBER(SEARCH(Data[[#Headers],[Perfect]],[@Teams]))*1

=ISNUMBER(SEARCH(Data[[#Headers],[Amazing]],[@Teams]))*1
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Hidden power of SUBTOTAL 

Matching keywords

Let’s move on the Output table.  In this table, we first enter the keywords of this challenged in the Data[Teams] column and we will leave the 
Data[Name] column blank:

We will now add another column to the Data Table called ‘Included’.  This column will determine whether to include a particular row in our Output 
table based upon a formula.  The formula is as follows:

=MIN(MMULT(Data[@[Awesome]:[Amazing]],Output[Included in filter]),1)

The first part of the formula, MMULT(Data[@[Awesome]:[Amazing]],Output[Included in filter]), multiplies two [2] selected vectors to obtain the 
dot product.  You can read more about MMULT in our A to Z of Excel Functions (earlier in this newsletter).  The resulting dot product shows how 
many matches the text strings have with the filter.  We then wrap this dot product in the MIN function to ensure that our output is either one [1] or 
zero [0], like a TRUE or FALSE value.

Then, we added one column to this Table and we call this column ‘Included in filter’.  This column will specify which keywords to include in the filter.  
The formula for this new column will be:

=SUBTOTAL(103,[@Teams])

The SUBTOTAL function has the advantage of being able to exclude hidden cells from calculations.  When the function_num is greater than 100, 
the SUBTOTAL function will not include any hidden cells in the calculation.

Using function_num 103 of SUBTOTAL, which is COUNTA, will return one [1] if a cell is not hidden and zero [0] if the cell is hidden.  For instance, if 
we completely hide the row 23, the result will be as follows:

As we can see that cell F23 value is zero [0] while another unhidden cell is one [1].
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Filter

Hide, but not completely

Below the Output table we will use FILTER function to filter out the list that contains the keywords:

=FILTER(Data[[Name]:[Teams]],Data[Included])

This will use the Included column in Data table to filter out all the match we have on the Data table and output it out in form of an array.  Therefore, 
we have the following output table: 

The project is currently 80% complete, but we need to hide rows 23 to 
25 from our output.  However, we need to be careful when hiding these 
rows.  We do not want to completely hide them, as this could cause the 
SUBTOTAL to become zero [0] or the filter to stop working.  

The lowest pixel height for a row that will still allow the  SUBTOTAL 
function to work is 1/3 pixel (0.25 points).  To achieve this, we can select 

the rows we want to hide and go to Home -> Cells -> Format -> Row 
Height (or use the shortcut key Alt + H + O + H) and enter 0.25 points in 
the box.  However, the filter of Excel will not work if cell is under one [1] 
pixel (0.75 points).  Therefore, we need to adjust the row height to one 
[1] pixel to ensure that our filter works properly.

After setting the row height to one [1] pixel, our filter is now complete:

It is important to note that anything typed below a Table will automatically add a new row to the Table.  Therefore, you may need to resize the 
Output table to exclude the new formula that was just added.

Now, we may use the drop-down menu from the Table to filter out Data[Teams] that contains the keywords we need.  The drop-down filter will 
automatically set the row height to zero [0] pixels for unselected criteria and maintain one [1] pixel for selected criteria.

Word to the Wise

We appreciate there are many, many ways this could have been achieved.  If you have come up with an alternative, radically different approach, 
congratulations – that’s half the fun of Excel!

Until next month.

mailto:contact@sumproduct.com
http://www.sumproduct.com
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Location Course Date Date Duration Duration

Melbourne Australia Excel Tips and Tricks 5 Feb 2024 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Melbourne Australia Financial Modelling 6 - 7 Feb 2024 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Melbourne Australia Power Pivot, Power Query and Power BI 8 - 9 Feb 2024 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Sydney Australia Power Pivot, Power Query and Power BI 19 - 20 Feb 2024 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Sydney Australia Excel Tips and Tricks 21 Feb 2024 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Sydney Australia Financial Modelling 22 - 23 Feb 2024 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Melbourne  Australia Power Pivot, Power Query and Power BI 18 - 19 Mar 2024 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days

Melbourne  Australia Excel Tips and Tricks 20 Mar 2024 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 1 Day

Melbourne Australia Financial Modelling 21 - 22 Mar 2024 09:00-17:00 AEDT (-1 day) 22:00-17:00 GMT 2 Days
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

contact@sumproduct.com
www.sumproduct.com
+61 3 9020 2071

Sydney Address:	 SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  We’ve started going through the 
alphabet actions. This month, it’s “S”: 

Keystroke What it does

ALT + SPACE Displays control menu

CTRL + SPACE Select column

SHIFT + SPACE Select row

CTRL + SHIFT + SPACE Select contiguous area

Subtract (-) Extend Selection mode

CTRL + Subtract (-) Delete cells

SHIFT + Subtract (-) Add to Selection mode

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.
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